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General Awareness
Instructions
For the following questions answer them individually
Question 1

Hillary Clinton who was in India recently is the U.S. Secretary of:

A  Commerce

B  State

C  Treasury

D  Defence

E    None of these
Answer: B

Question 2

If Indian Banking industry had demonstrated its resilience to external shocks in 2008-09, the credit goes 
to:

1. Policies of the RBI & the Govt. of India
2. Strength of Indian Business Houses
3. Foreign aid/investments to Indian companies

A  Only 1

B  Only 2

C  Only 3

D  All 1, 2 & 3

E    None of these
Answer: A

Question 3

Tembhli village which was in news is in:

A  Bihar

B  Rajasthan

C  Orissa

D  West Bengal

E    Maharashtra
Answer: E

Question 4

Rohan Bopanna who represented Indian in an international event is a:
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A  Billiards Player
B  Golf Player

C  Chess Player

D  Table Tennis Player

E    Lawn Tennis Player
Answer: E

Question 5

AIBA Women’s World Boxing Championship was organized in September 2010 in:

A  Rome

B  New Delhi

C  London

D  Vienna

E    Barbados
Answer: E

Question 6

Mr. a:K. Antony a Union Minister in the Indian Cabinet recently signed an agreement with South
Korea:This means the agreement is for the Cooperation in the field of:

A  Agriculture

B  Rural Development

C  Defence

D  Steel & Iron

E    None of these
Answer: C

Question 7

What is financial inclusion?

A  To provide a permanent employment to the unemployed

B  To provide a 100 days job to all those who are in need of a job

C  To provide banking services to all those living in remote areas

D  To ensure that all financial transactions amounting 5,000/- and above are done through banks.

E    To provide finances for all
Answer: C
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Question 8

Recently the term 3G was very much in news and even a conference on it was organized in India:What is 
the letter ‘G’ denotes in 3G?

A  Grade

B  Group

C  Global

D  Guild

E    Generation
Answer: E

Question 9

Some major banks and financial institutions in various Western countries were to wind up their business
and/or declare themselves in financial problems during last few years. This trend is technically known as:

A  Devaluation

B  Deformation

C  Global Slowdown

D  Political’ backdrop

E    Globalisation
Answer: C

Question 10

Which of the following international sports events was organized in Delhi in October 2010 in which
several countries participated?

A  Asian Games

B  World Cup Cricket Tournment

C  Asian Hockey Tournament

D  Commonwalth Games

E    None of these
Answer: D

Question 11

Exporters in India get insurance cover and risk cover from which of the following organizations?

A    SIDBI
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B    NABARD

C    ECGC

D    RBI

E    None of these
Answer: C

Question 12

Which of the following places in India does not have a Stock Exchange?

A  Kolkata

B  Ahmedabad

C  Mutnbai

D  Delhi

E    Udaipur
Answer: E

Question 13

Sir Mota Singh who was Knighted by the Queen Elizabeth II earlier this year is:

A  first Sikh Judge in UK

B  first Sikh Minister in UK

C  first Indian to become Vice Chancellor in Cambridge

D  first Indian to become Governor of a State in USA

E    None of these
Answer: A

Question 14

‘Ayodhya’ which was in news recently is a place in:

A  Madhya Pradesh

B  Bihar

C  Rajasthan

D  Jharkhand

E    Uttar Pradesh
Answer: E

Question 15

Which of the following is the name of a private sector Bank in India?
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A  IDBI Bank
B  Axis Bank

C  Corporation Bank

D  UCO Bank

E    All are Private Banks
Answer: B

Question 16

The Govt. of India does not provide any direct financial assistance to which of the following schemes?

A  Mahatma Gandhi National Rural Employment Guarantee scheme

B  Rural Health Mission

C  Indra Aawas Yojana

D  Jeevan Sathi Yojana

E    Rajiv Gandhi Grameen Vidyutikaran Yojana
Answer: D

Question 17

What does the letter ‘S' denotes in ‘AFSPA’ an abbreviation we very often see in newspapers?

A  Slow

B  Special

C  State

D  Solid

E    Sovereign
Answer: B

Question 18

Which of the following terms is used in banking and finance?

A  Abiotic

B  Demand Deposit

C  Fat scales

D  A diabetic

E    Cathode
Answer: B
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Question 19

Which of the following is a food crop?

A  Maize

B  Cotton

C  Palm

D  Jute

E    Jatropha
Answer: A

Question 20

Vedanta Alumina is a company operating in the area of

A  Shipping

B  Mining

C  Cement

D  Taxtiles

E    Baniking
Answer: B

Question 21

Names of which of the following rates/ratios cannot be seen in financial newspapers?

A  Bank Rate

B  Repo Rate

C  Cash Reserve Ratio

D  Pulse Rate

E    Statutory Liquidity Ratio
Answer: D

Question 22

An individual visting UAE will have to make his/her payments in which of the following currencies?

A  Dirham

B  Taka

C  Baht

D  Peso
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E    Dinar
Answer: A

Question 23

Who amongst the following is NOT a famous writer?

A  Sania Mirza

B V.S. Nacipaul

C  Chetan Bhagat

D  Khushwant Singh

E    Namita Gokhale
Answer: A

Question 24

‘Peepli Live’ is a film directed by:

A  Anusha Rizvi

B  Aamir Khan

C  Kiran Rao

D  David Dhawan

E    None of these
Answer: A

Question 25

Which of the following is the Chemical name of the salt we use in our kitchen?

A  Calcium Carbonate

B  Calcium Chloride

C  Sodium Carbonate

D  Sodium Chloride

E    Ammonium Sulphate
Answer: D

Question 26

The judges of the Supreme Court of India now retire at the age of
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A  58 years
B  60 years

C  62 years

D  65 years

E    68 years
Answer: D

Question 27

Operation New Dawn is the beginning of stability in:

A  Afghanistan

B  Iran

C  Sudan

D  Sri Lanka

E    Iraq
Answer: E

Question 28

Which of the following books is written by Kiran Desai?

A  A house for Mr. Biswas

B  3 Mistakes of My Life

C  A Tale of Two Sisters

D  The Inhertance of Loss

E    Tale of Two Cities
Answer: D

Question 29

Jimena Navarrete who was crowned Miss Universe 2010 is from:

A  Hydraulic

B  Thermal

C  Nuclear

D  Solar

E    All of these forms
Answer: A
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Question 30

India has an agreement with USA for producing energy in the form of

A  Hydraulic

B  Thermal

C  Nuclear

D  Solar

E    All of these forms
Answer: C

Question 31

Which of the following is an economic term?

A  Plaintiff

B  Bunker Blaster

C  Deflation

D  Lampoon

E    Zero Hour
Answer: C

Question 32

Which of the following awards is given to sports persons in India?

A  Shantiswarup Bhatnagar Awards

B  Arjuna Award

C  Kalidas Samman

D  Saraswati Samman

E    None of these
Answer: B

Question 33

Which of the following is the trophy/cup associated with the game of cricket?

A  Derby

B  Merdeka Cup

C  Santosh Trophy

D  Duleep Trophy

.

https://cracku.in


E    Durana Cup
Answer: D

Question 34

Who amongst the following can take benefit of the Social Security Fund established by the Govt. of India
for unorganized workers?

A  Primary school teacher

B  Employee of Sugar Factor

C  Taxtile Mazdoor

D  Rickshaw Puller

E    Clerk in a factory
Answer: D

Question 35

Shushil Kumar who won a Gold Medal at an international event is a famous:

A  Wrestling champion

B  Golf player

C  Table Tennis Player

D  Weight lifter

E    None of these
Answer: A

Question 36

In case a major war breaks out between two nations, which of the following organization/ agencies will
be seen in the battle field, in addition to the armies of the fighting parties?

A  WTO

B  Red Cross

C  CARE

D  OPEC

E    NPA
Answer: B

Question 37

Which of the following is the abbreviated name asssociated with food security?

A    ASHA
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B    PDS

C    WTO

D    OPEC

E    NPA
Answer: B

Question 38

Which of the following is a good and rich source of vitamin ‘C’?

A  Milk

B  Radish

C  Mango

D  Lemon Juice

E    Banana
Answer: D

Question 39

Who amongst the following Indian Prime Ministers was honoured Posthumously by the Govt. of
Bangladesh for his/her contributions to the independence of the nation ?

A  Rajeev Gandhi

B  Jawaharlal Nehru

C  Indira Gandhi

D  Lal Bahadur Shastri

E    None of these
Answer: C

Question 40

Who amongst the following was never a Governor of the RBI?

A  Bimal Jalan

B Y.V. Reddy

C  Arup Roy Choudhury

D  c: Rangarajan

E    d: Subbarao
Answer: C
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English
Instructions

Read the following passage carefully and answer the questions given below it. Certain words are printed in bold to help 
you to locate them while answering some of the questions. Once upon a time there lived a queen in the city of 
Benaras. Her name was Khema and she was the wife of King Bahuputtaka:One night, the Queen had a dream of a 
beautiful golden goose that spoke with great wisdom, almost as if he was a sage: She told her husband that she 
desperately wanted to see a bird just like the one in her dream. So the King aksed his ministers to find out all that they 
could about a bird such as this. He was told that such a bird did exist but was extremely rare and difficult to find: They 
advised him to build a beautiful lake aon the outskirts of Benaras so that he may attract such rare and lovely creatures 
to reside there: In this way the queen might have her wish. Towards the norh, on Mount Cittakuta, there lived about 
ninety thousand wild geese headed by a beautiful golden goose called King Dhatarattha He got to hear of this 
exquisite lake surrounded by water lilies and lotuses floating on the surface: The kKing had invited all the birds to 
come and live on it, promising that one of them would ever be harmed: Corn was acattered on a daily basis in order to 
attract the birds. So a couple of geese went up to their King, the golden goose and told him that they were quite tired 
of living up on the mountains and would like to see this wonderful lake where they had been promised food and 
protection. The king agreed to their request and took the floc down south towards Benaras. Meanwhile, at the lake ing 
Bahuputtaka had placed hunters all around in order to capture any golden goose that happened to pass by. So the 
next morning when the headhunter saw this flock of geese approaching he was very excited to see their golden leader. 
He immediatey went about setting up a snare amongst the water lilies and lotuses, as he knew that the leader would 
definitely be the first to alight. The whole flock came flying down in one mighty seoop and as expected it was the 
King’s foot that touched the water first. He was esnsnared and could not escape: Seeing this, the other geese flew into 
a panic: But none had the courage to try to free their king and so flew back to Mount Cittacuta for safety. All except 
one: He was the chief captain, Sumukha:King Dhatarattha entreated him to fly to safety too, as he would surely be 
captured if he stayed by his sid: But Sumukha replied that he would never desert his master in the face of danger and 
swould either try to save him or die by his side: At this point the hunter approached and as Sumukha saw him he 
decided to appeal to his compassion. The hunter asked the golden goose how come he had not noticed the trap that 
was set. The golden goose replied that when one’s time was up it was no use to struggle against what was fated and 
one must just accept it. The huntsman was very impressed with his grace and wisdom. He then turned to Sumukha 
and asked why he had not fled with the other birds even though he was free to do so. Sumukha answered that the 
golden goose was his King, best friend and master and that he could never desert him even at the cost of his own life: 
Hearing this, the hunter realised that these were a couple of rare birds of great nobility. He did not much care for his 
own King’s reward and decided to do the right thing and set them free: He told Sumukha that as he was ready to die 
for his ing he would set them both free to fly wherever they wish.
Question 41

Why were the geese keen on visiting the lake in Benaras?

A  They were invited perpsonally by king Bahuputtaka:

B  They were tired of their. old lake:

C  They were amused by the water lilies and lotuses.

D  The lake was not very far from the mountains.

E  
c: They were amused by the water lilies and lotuses.
d: The lake was not very far from the mountains.
e: To lake was to be as source of good food and protection.

Answer: E

Question 42

Why did the king approach the ministers?

A    In order to find out the best location for the lake:
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B    In order to find out if a golden goose existed:

C    TO enquire about his wife’s dreams.

D    c: TO enquire about his wife’s dreams.
d: To devise a plan to capture all rare bird species.

E  
b: In order to find out if a golden goose existed:
c: TO enquire about his wife’s dreams.
d: To devise a plan to capture all rare bird species.
e: To enquire about the best hunter in the locality.

Answer: B

Question 43

Why did the head hunter release the king, the golden goose?

A  He was impressed by his wisdom and nobility.

B  The geese were a rere species of birds.

C  The golden goose, King Dhatarattha promised him a handsome rewar

D  d: The hunter sympathised with the golden goos

E    e: The huntter did not want the chief captain to lose a friend:
Answer: A

Question 44

What was the king’s tintention behind building a take?

A  To attract all rare species of living animals and birds.

B  To beautify the city of Benaras.

C  He did not want to go against the wishes of his wife:

D  He wanted to capture the golden gods

E    d: He wanted to capture the golden godse:
e: He enjoyed bird watching and wanted to create a natural habitat for them.

Answer: A

Question 45

Why did the flock of geese panic and retreat to Mount Cittacuta?

A  Their king took the wrong route to the lake and they lost their way.

B  Their king, the golden goose was captured:

C  Their chief captain, Sumukha betrayed the king.

D  c: Their chief captain, Sumukha betrayed the king.
d: They spotted many hunters by the lak

E  e: None of these
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Answer: B

Question 46

What advice did the minister give to the king?

A  That no such golden goose existed and he was only wasting his time spearching
for one:

B  To create an artificial golden goose for the queen.

C  To build a lake in order to attract the golden goose:

D  To open a sanctuary of rare birds for the queen.

E  
b: To create an artificial golden goose for the queen.
c: To build a lake in order to attract the golden goose:
d: To open a sanctuary of rare birds for the queen.
e: To have a beautiful garden surrounded by flowers and trees.

Answer: C

Question 47

Which of the following statements would best describe the qualities of Sumukha?
1. Betrayer of the flock.
2. The Selfless Goose:
3. Loyal towards the king.
4. The naive and ignorant goose:

A  Only 1

B  Only 2

C  Only 3 and 4

D  Only 1 and 4

E    Only 2 and 3
Answer: E

Instructions

Choose the world which is most nearly the same in meaning as the word printed in bold as used in the passege:
Question 48

EXQUISITE

A  Expensive

B  Delicate

C  Elaborate

D  Wonderful

E    Efficient
Answer: D
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Question 49

SNARE

A  Trap

B  Alarm

C  Plan

D  Arangement

E  Protection
Answer: A

Question 50

DESERT

A  Displease

B  Encourage

C  Instigate

D  Escort

E  Abandon
Answer: E

Instructions

In each of the following sentences, an idiomatic expression or a proverb is highlighted: Select the alternative which
best describes its use in the sentence:
Question 51

The course of events made it necessary for Joseph to start working.

A  events that were planned

B  long list of future events

C  success on unexpected events

D  nature of events that followed after Joseph joined work

E    None of these
Answer: C

Question 52

The team put their plan into execution the very next day.

A    proposed a plan.

B    discussed their plan.
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C    started thinking about a plan.

D    started carrying out their plan.

E    None of these
Answer: D

Question 53

Mrs Nayak opened the discussion on the “alarming rate of poverty in India”.

A  started the discussion.

B  gave her opinion in the discussion.

C  did not agree on the discussion.

D  Welcomed the people to the discussion.

E    None of these
Answer: A

Question 54

The new law on “Right to Food Safety” will come into force next month.

A  be forced upon the people

B  be associated from next month onwards.

C  be implemented next month

D  be withdrawn next month.

E    be widely rejected next month.
Answer: C

Question 55

When the girl wanted to stay out past midnight, her father put his foot down.

A  gave in to her request

B  walked away disapprovingly.

C  obstructed her from leaving the house

D  requested her to be home on tim

E    None of these
Answer: C

Instructions

Read each sentence to find out whether there is any grammatical error in it. The error, if any, will be in one part of the
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sentence: The number of that part is the answer. If there is no error, the answer is (5) i.e: ‘No Error’ (Ignore the errors
of punctuation, if any.
Question 56

(A) A public safety advertising/(B) campaign in Russia/(C) hope to draw attention/(D) of pedestrians
crossing the road/(E) No Error.

A  A public safety advertising

B  campaign in Russia

C  hope to draw attention

D  of pedestrians crossing the road

E    No Error
Answer: C

Question 57

(A) Nuclear waste will still being/(B) radioactive even after twenty thousand years,/ (C) so it must be
disposed/(D) of very carefully. (E) No Error.

A  Nuclear waste will still being

B  radioactive even after twenty thousand years

C  so it must be disposed

D  of very carefully

E    No Error
Answer: A

Question 58

(A) My friend lived at the top/(B) of an old house/ (C) which attic had been/(D) converted into a flat./(E)
No Error.

A  My friend lived at the top

B  of an old house

C  which attic had been

D  converted into a flat

E    No Error
Answer: C

Question 59

(A) The Renaisssance was/(B) a time to ‘reawakening’/(C) in both the arts/(D) and the sciences./(E) No
Error.
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A  The Renaisssance was

B  a time to ‘reawakening’

C  in both the arts

D  and the sciences

E    No Error
Answer: B

Question 60

(A) A cash prize was/(B) award to the most/ (C) successful salesman of the year/(D) by the President of
the company.(E) No Error.

A  A cash prize was

B  award to the most

C  successful salesman of the year

D  by the President of the company

E    No Error
Answer: B

Instructions

Each sentence below has a blank/s, each blank indicates that something has been omitted: Choose the word/s that
best it/s the meaning of the sentence as a whole:
Question 61

The state-of-the-art school is………….. with a medical clinic and fitness center.

A  establish

B  illustrative

C  having

D  equipped

E    compromising
Answer: D

Question 62

Many leading members of the opposition party………………. to justify the party’s decision.

A    having tried

B    has tried

C    have been trying
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D    tries

E    is trying
Answer: C

Question 63

The charity……………………….. most of its money through private donations.

A  receives

B  borrows

C  uses

D  proposes

E    invests
Answer: A

Question 64

The Bhagavad Gita is a part of the Mahabharata, but it stands…………… and is………………. in itself.

A  dependent, incomplete

B  together, justified

C  separate, dignified

D  apart, complete

E    united, connected
Answer: D

Instructions

In each question below, four words printed in bold type are given. These are numbered (A), (B), (C) and (D). One of
these words printed in bold may either be wrongly spelt or inappropriate in the context of the sentence: Find out the
word that in inappropriate or wrongly spelt, if any. The number of that word is your answer. It all the words printed in
bold are correctly spelt and appropriate in the context of the sentence then mark (5) i.e: ‘All Correct’ as your answers.
Question 65

(A) Employees must familiarise/(B) themselves with the health/(C) and safety/ (D) mannual of the
organisation./(E) All Correct.

A  Employees must familiarise

B  themselves with the health

C  and safety

D  mannual of the organisation

E    All Correct
Answer: D
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Question 66

(A) The politicall(B) environment is no/(C) conclusive to economic/(D) reforms./(E) All Correct.

A  The politicall

B  environment is no

C  conclusive to economic

D  reforms

E    All Correct
Answer: C

Question 67

(A) ship was at sea for many days and/(B) finally/(C) anchored near the (D) costlinej (E) All correct.

A  ship was at sea for many days and

B  finally

C  anchored near the

D  costlinej

E    All Correct
Answer: D

Question 68

(A) Some of our regular listenors have/(B) complained about the new/(C) programmes /(D)schedule/(E) All
Correct.

A  Some of our regular listenors have

B  complained about the new

C  programmes

D  schedule

E    All Correct
Answer: A

Question 69

(A) The report found that the (B) saefty equipment had been very/(C) poorly/(D) maintained:/(E) All
Correct.

A    The report found that the
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B    saefty equipment had been very

C    poorly

D    maintained

E    All Correct
Answer: B

Instructions

Rearrange that following six sentences/ group of sentences/( I ), (2), (3), (4), (5) and (6) in the proper sequence to
form a meaningful paragraph; then answer the questions given below them.
1. The merchant greadily counted his gold and said, “The purse I dropped had 200 pieces of gold in it. You’ve already
stolen more than the reward! Go away or I will tell the police:”
2. The judge, looking towards the merchant said, “you stated that the purse you lost contained 200 pieces of gold:
Well, that’s considerable: cost. But the purse this beggar found had only 100 pieces of gold”.
3. Being an honest man, the beggar came forward and handed the purse to the merchant saying, “Here is your purse:
May have my reward now?”
4. “This purse therefore cannot be the one you lost.” And, with that, the judge gave the purse and all the gold to the
beggar.
5. A beggar found a leather purse that someone had dropped in the marketplace: On opening it, he discovered that it
contained 100 pieces of gold: Then he heard a merchant shout, “A reward! A reward to the one who finds my leather
purse”.
6. “I am an honest man,” said the beggar defiantly “Let us take this matter to the court. The judge patiently listened
to both sides of the story.
Question 70

Which of the following should be the FIFTH sentence after the rearrangement?

A  5

B  4

C  2

D  3

E    6
Answer: C

Question 71

Which of the following should be the SECOND sentence after the rearrangement?

A  1

B  4

C  6

D  2

E    3
Answer: E
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Question 72

Which of the following should be the SIXTH (LAST) sentence after the rearrangement’?

A  1

B  4

C  5

D  6

E    3
Answer: B

Question 73

Which of the following should be the FIRST sentence after the rearrangement?

A  5

B  2

C  4

D  3

E    6
Answer: A

Question 74

Which of the following should be the FOURTH sentences after the rearrangment?

A  4

B  6

C  2

D  5

E    3
Answer: B

Instructions

In the following passage, there are blanks, each of which has been numbered: These numbers are printed below the
passage and against each, five words are suggested, one of which fits the blank appropriately. Find out the
appropriate word in each case:
The Bhagavad Gita is a poem of (1)verses which is a part of the Mahabharata:It is the only philosophical song existing
in all languages. Its popularity and influence have never waned: It abl light and guidance to the troubled mind in times
of crisis. It is in the (2) of a dialogue between Arjuna and Krishna on the battlefied: Arjuna’s mind is troubled at the
hrough of the killing of his friends and relatives. He cannot conceive aof any gain. Arjuna is the (3) of the tourtured
spirit of man torn by conflicting obligations and moralities. The dialogue proceeds and takes us to the higher level of
individual duty and social behaviour, application of ethics to practical life and social outlook that should govern all. An
attempt is (4) to reconcile the three paths of human advancement– the path of knowledge the path of action and the
path of faith. But more .(5) is laid on faith. There is a call of action to meet the obligations of life, keeping in view the
spiritual background and the large purpose of the universe:

.
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Question 75

(1)

A  shines

B  enforces

C  secures

D  seeks

E  provides
Answer: E

Question 76

(2)

A  constitution

B  part

C  formation

D  form

E    programme
Answer: D

Question 77

(3)

A  dream

B  source

C  figures

D  symbol

E  conceived
Answer: D

Question 78

(4)

A  made

B  established

C  coined

D  given

E  generated
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Answer: A

Question 79

(5)

A  significant

B  declaration

C  emphasis

D  blessings

E    important
Answer: C

 Computer Knowledge

Instructions
For the following questions answer them individually
Question 80

Marketing in Banks is required for ……………………

A  Getting new customers

B  Retaining existing customers

C  Lending

D  Accepting of deposits

E    None of these
Answer: E

Question 81

Service Mareting is the same as ……………………..

A  Relationship Marketing

B  Transaction Marketing

C  Internal Marketing

D  All of these

E    None of these
Answer: A
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Question 82

Marketing size means………………..

A  Size of marketing staff

B  Size of the Organisation

C  Scope for profits

D  Scope for marketing

E    All of these
Answer: D

Question 83

Market size means…………………….

A  Market price of shares

B  Sensex

C  Share market

D  Share of business among peers

E    None of Market volatility
Answer: D

Question 84

Internal Marketing means………………..

A  Selling to oneself

B  Selling to the employees

C  Selling of samples

D  Selling to foreign markets

E    None of these
Answer: B

Question 85

A ‘Call’ means………………….

A    A Profession

B    Teletalk

C    Calling on a Propspect

.

https://cracku.in


D    A Call Centre

E    All of these
Answer: C

Question 86

A ‘Call Centre’ is……………………

A  A place where Salesmen meet every day

B  A Training Centre

C  A Back Office set up where customer queries are answered

D  Customers’ meeting place

E    All of these
Answer: C

Question 87

A presentation means………………….

A  Display of products

B  Explaining the utility of products

C  A gift

D  Display of Communication skills

E    All of these
Answer: B

Question 88

A DSA means …………..

A  Directly Selling Authority

B  Directly Selling Agent

C  Direct Selling Authority

D  Direct Selling Agent

E    Distributors & Selling Agencies
Answer: D

Question 89

‘Benchmark’ means……………

A    Products lined up on a bench
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B    Better value for higher price

C    Costlier service

D    Additional service

E    All the above
Answer: C

Question 90

Value - added services means………………..

A  Giving full value for money

B  Better value for higher price

C  Costlier service

D  Additional service

E    All the above
Answer: D

Question 91

CRM means ……….

A  Customer Relationship Management

B  Customer Retention Manager

C  Customers’ Relatives Meet

D  Channel Rothe Market

E    Channel Representative Manager
Answer: A

Question 92

A ‘Target Group’ in Marketing means……………….

A  To whom the sales should be directed

B  A Group of Sellers

C  A Group of Buyers

D  A Group of Products

E    All the above
Answer: A
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Question 93

The Target Group for Credit Cards is…………………..

A  All Card holders

B  All existing borrowers

C  Individuals with taxable income

D  All of these

E    None of these
Answer: C

Question 94

Bancassurance means ………………..

A  Assurance given by banks to Loanees

B  Assurance to bank with one bank

C  Assurance to repay loans

D  Assurance to give good service

E    Selling insurance products through banks
Answer: E

Question 95

Cross - selling means………………

A  Selling with a cross face

B  Selling to Red Cross members

C  Selling to Blue Cross members

D  Selling across countries

E    Selling other products to existing customers
Answer: E

Question 96

ATM means…………………

A  Any Time Marketing

B  Any Time Money

C  Any Time Machine

D  Automatic Teller Machine
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E    Automatic Teller Money
Answer: D

Question 97

Digital Marketing is………………

A  a way of Direct Marketing

B  a way of Indirect Mareting

C  a strategy of the DSAs

D  All of these

E    None of these
Answer: A

Question 98

Market segmentation helps in

A  Identifying the garget group

B  Focussed marketing

C  Improved lead generation

D  Only 1 & 2

E    All 1, 2 & 3
Answer: D

Question 99

Only one of the following is true: Find the same:

A  Marketing is not required in a monopolistic situation

B  Marketing is not required in Public enterprises

C  Marketing depends on competitors’ performance

D  Marketing has no role to play in production levels

E    Motivated employees do not require sales incentives.
Answer: C

Question 100

Price is an important factor for effective marketing. What are the other Ps?

A    Product, Promotion & Place

B    Place, Persuasion & Promotion
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C    Pride, Person & Place

D    Product, Paper & Person

E    None of these
Answer: A

Question 101

Advertisements are required for…………………

A  Boosting the production levels

B  Motivating the employees

C  Boosting the sales

D  All of these

E    None of these
Answer: C

Question 102

Sales forecasting involves study of………………

A  Proper selling price

B  Sales planning

C  Distribution outlets

D  Consumer needs and demands

E    All of these
Answer: E

Question 103

Market Research is needed for ………….

A  Choosing the right sales persons

B  Choosing the right products

C  Marking proper marketing decisions

D  Deciding the sales incentives

E    None of these
Answer: C

Question 104

Marketing is termed as successful, when…………………..

.
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A  There is a rise in the number of salesmen
B  There is no need for post - sales service

C  There is no need to give discounts

D  There is rise in sales through more clients

E    Marketing is an ongoing process and hence, can never be successful.
Answer: D

Question 105

What happens when you press the Ctrl + V key?

A  A Capital V letter is typed into your document at the cursor point

B  The selected item is pasted from the Clipboard

C  The selected item is pasted to the Clipboard

D  The selected drawing objects are distributed vertically on the page

E    None of these
Answer: B

Question 106

Which do you press to enter the current date in a cell?

A  CTRL + ; (semicolon)

B  CTRL + SHIFT + : (colon)

C  CTRL + F 10

D  CTRL + F 11

E    None of these
Answer: A

Question 107

Which of the following describes a relational database?

A  It provides a relationship between integers

B  It consists of separate tables of related data

C  It retrieves data related to its queries

D  It provides a relationship between floats

E    None of these
Answer: B
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Question 108

How do you print your slides in a handout that includes lines for notes?

A    In the Print dialog box, select Handouts and set the number of slides per page to 3

B    In the Print dialog box, select Handouts and a number of slides per page, then select the Include comment pages
option

C    In the Print dialog box, select Notes Pages instead of Handouts

D    In cannot be done

E    None of these
Answer: A

Question 109

Suppose you have columns of data that span more than one printed page: How can you automatically
print the column headings on each page?

A  Click Page Setup on the File menu, click the Sheet tab, and enter the row that contains these column headings
under Print titles

B  Click Page Setup on the File menu, click the Page tab, click the Options button, then enter your choices

C  Click Page Setup on the File menu, click the Sheet tab, and make a selection under the Prin heading

D  Click Page Preview on the File menu, click the Sheet tab, and enter the row that contains these column headings
under Print titles

E    None of these
Answer: A

Question 110

The Assistant is………………

A  an application that allows you to take notes and save them in a file

B  an animated character that provides help and suggestions

C  a button on the standard Toolbar that executes the Print command

D  a collection of frequently misspelled words in a dictionary file

E    None of these
Answer: B

Question 111

Which of the follwing place the common data elements in order from smallest to largest?

A    Character, file, record, field, database

B    Character, record, field, file, database
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C    Character, field, record, file database

D    Bit, byte, character record, field, file, database

E    None of these
Answer: D

Question 112

Select the odd one out

A  Interpreter

B  Operating System

C  Compiler

D  Assembler

E    None of these
Answer: B

Question 113

Which of these is a quick way to copy formatting from a selected cell to two other cells on the same
worksheet?

A    Use CTRL td select all three cells, then click the Paste Button image button on the Standard toolbar

B    Copy the selected cell, then select the other two cells, click Style on the Format menu, then click Modify

C    Click Format Painter Button image on the Formatting toolbar twice, then click in each cell you want to copy the
formatting to

D    Use Alt to select all three cells, then click the Paste Button image button on the Standard toolbar

E    None of these
Answer: C

Question 114

How do you prevent emailed word documents from always opening in the Reading Layout?

A  From the Tools Menu > Options > General Tab > uncheck the: ‘Allow starting in Reading Layour’

B  From the View Menu > Reading Layout > General Tab > uncheck the ‘Allow starting in Reading Layout’

C  From the Format Menu > Autoformat > Edit Tab > uncheck the ‘Use with emailed attachements’

D  All the above

E    None of these
Answer: A

Question 115

By default document is printed in mode…………….
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A  Land scap

B  Portrait

C  Page setup

D  Print view

E    None of these
Answer: B

Question 116

Which one of the following is the small singal-size network?

A  LAN

B  DSL

C  RAM

D  USB

E    None of these
Answer: A

Question 117

How can be done the page break in word’?

A  Pressing the key FL before the cursor has put at the proper place:

B  Pressing control + Enter, before the cursor has put at the proper place:

C  Using the insert/section break

D  Changing the font size of documents

E    None of these
Answer: B

Question 118

What shows the contents of active cell.

A  Name box

B  Row heading

C  formulla bar

D  Task pan
E    None of these
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Answer: C

Question 119

To search and to load the soved file

A  select the dose command

B  select the new command

C  select the save command

D  select the open command

E    None of these
Answer: E

Explanation:
QUANTITATIVE APTITUDE

 Quant

Instructions

What should come in place of the question mark (?) in the following questions?
Question 120

38 % of 4500 — 25% of ? = 1640

A  260

B  270

C  280

D  290

E    None of these
Answer: C

Explanation:
Expression : 38 % of 4500 — 25% of ? = 1640

=> 

=> 

=> 

=> 

Question 121

A    33

( ×100
38

4500) − ( ×100
25

x) = 1640

1710 − =4
x

1640

=4
x

1710 − 1640 = 70

x = 70 × 4 = 280

(?) +2 15 −2 33 =2 97
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B    32

C    34

D    30

E    None of these
Answer: E

Explanation:
Expression : 

=> 

=> 

=> 

= 
Question 122

A  1512

B  1521

C  1251

D  1531

E    None ot these
Answer: B

Explanation:
Expression : 

=> 

=> 

=> 
Question 123

A  

B  

C  

D  

E    None of these
Answer: C

Explanation:
Expression : 

(?) +2 15 −2 33 =2 97

(?) +2 225 − 1089 = 97

(?) −2 864 = 97

(?) =2 97 + 864 = 961

? = =961 31

(7921 ÷ 178) − 5.5 = ?

(7921 ÷ 178) − 5.5 = ?

=? ( ) −178
7921

5.5

=? 44.5 − 5.5 = 39

? = (39) =2 1521

+10
9

+11
3

=15
7

?

1 330
217

1 330
221

1 330
211

1 330
197

+10
9

+11
3

=15
7

?

297+90+154
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= 

= 

Question 124

1/4th of 1/2 of 3/4th of 52000=?

A  4875

B  4857

C  4785

D  4877

E    None of these
Answer: A

Explanation:
Expression = 1/4th of 1/2 of 3/4th of 52000=?

= 

= 
Question 125

A 

B 

C 

D 

E    None of these
Answer: B

Explanation:
Expression : 

= 

= 
Question 126

A    805
B    803

C    807

330
297+90+154

=330
541

1 330
211

×4
1

×2
1

×4
3

52000

3 × 1625 = 4875

×67
57

×171
32

=128
45

?

262
15

268
15

266
15

268
17

×67
57

×171
32

=128
45

?

×67
1

×3
1

4
45

268
15

283 × 56 + 252 = 20×?
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D    809

E    None of these
Answer: A

Explanation:
Expression : 

=> 

=> 

Question 127

A  2955.5

B  2905.5

C  2590.5

D  2909.5

E    None of these
Answer: B

Explanation:
Expression : 

= 

= 
Question 128

A  18

B  13

C  15

D  11

E    None of these
Answer: E

Explanation:
Expression : 

=> 

=> 

=> 

283 × 56 + 252 = 20×?

15848 + 250 = 20×?

? = =20
16100

805

(5863 − ) ×2704 0.5 =?

(5863 − ) ×2704 0.5 =?

(5863 − 52) × 2
1

=2
5811

2905.5

−? =3 42875 21

−? =3 42875 21

−? =3 35 × 35 × 35 21

35−? = 21

? = 35 − 21 = 14
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Question 129

A  17255

B  17551

C  17515

D  17155

E    None of these
Answer: D

Explanation:
Expression : 

= 

Instructions

What should come in place of the question mark (?) in the following number series?
Question 130

1, 5, 13, 29, ?, 125, 253

A  83

B  69

C  61

D  65

E    None of these
Answer: C

Explanation:
Successive powers of 2 are added

1 +  = 5

5 +  = 13

13 +  = 29

29 +  = 61

61 +  = 125

125 +  = 253
Question 131

45, 57, 81, 117, 165, ?

A    235
B    215

25639 − 5252 − 3232 =?

25639 − 5252 − 3232 =?

17155

22

23

24

25

26

27
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C    205

D    245

E    None of these
Answer: E

Explanation:
Multiples of 12 are added to each number
45 + 12 = 57
57 + 24 = 81
81 + 36 = 117
117 + 48 = 165
165 + 60 = 225

Question 132

353, 354, 351, 356, 349, ?

A  348

B  358

C  338

D  385

E    340
Answer: B

Explanation:
The pattern here followed is :
353 + 1 = 354
354 - 3 = 351
351 + 5 = 356
356 - 7 = 349
349 + 9 = 358

Question 133

A  2

B  4

C  61

D  latek1
E    latek2

Answer: A

, , , 1, 1 , 1 , 1 , ?4
1

2
1

4
3

4
1

2
1

4
3
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Explanation:
 is added to each number

+ =

+ =

+ = 1

1 +  = 

+ =

+ =

+ = 2
Question 134

17, 18, 26, 53, 117, ?, 458

A  342

B  142

C  3257

D  262

E    242
Answer: E

Explanation:
Cubes of natural numbers are added in the series

17 +  = 18

18 +  = 26

26 +  = 53

53 +  = 117

117 +  = 242

242 +  = 458
Instructions
For the following questions answer them individually
Question 135

If the numerator of a certain fraction increased by 200% and the denominator is increased by 150% the
new fraction thus fromed is 9/10. What is the original fraction?

A  3/4

B  1/4

C  3/5

D  2/5

E    None of these
Answer: A

4
1

4
1

4
1

2
1

2
1

4
1

4
3

4
3

4
1

4
1

1 4
1

1 4
1

4
1

1 2
1

1 2
1

4
1

1 4
3

1 4
3

4
1

13

23

33

43

53

63
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Explanation:
Let the original fraction = 

=> 

=> 

=> 

Question 136

The average of five numbers is 49. The average of the first and the second numbers is 48 and the
average of the fourth and fifth numbers is 28. What is the third number?

A  92

B  91

C  95

D  Cannot be determined

E    None of these
Answer: E

Explanation:
Let the numbers be 

=> 

Also, 

and 

=> 
Question 137

28% members of a certain group are married: What is the respective ratio between the number of
married members to the number of unmarried members?

A  7 : 17

B  5 : 18

C  7 : 18

D  Cannot be deterimed

E    None of these
Answer: C

Explanation:
Let the total members in the group = 

Married members = 

Unmarried members = 

=> Required ratio = 

= 

y
x

∴ =y×250
x×300

10
9

=y×5
x×6

10
9

=y
x

×10
9

6
5

=y
x

4
3

A , A , A , A , A1 2 3 4 5

A +1 A +2 A +3 A +4 A =5 49 ∗ 5 = 245

A +1 A =2 48 ∗ 2 = 96

A +4 A =5 28 ∗ 2 = 56

A =3 245 − 96 − 56 = 93

100x

×100
28

100x = 28x

100x − 28x = 72x

28x : 72x

7 : 18
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Question 138

Mr. Khanna took a loan of Rs.10,000/- on simple interest for two years at the rate 3 p.c:p.a:The total
amount that he will be paying as interest in 2 years is 3% of his monthly salary. What is his monthly
salary?

A  Rs.30,000/ -

B  Rs. 16,000/-

C  Rs.20,000/-

D  Rs. 12,000/-

E    None of these
Answer: C

Explanation:

= 

= Rs. 

 Mr. Khanna's monthly salary

= 

= Rs. 

Question 139

In how many different ways can the letters of the world ‘SECOND’ be arranged?

A  720

B  120

C  5040

D  270

E    None of these
Answer: A

Explanation:
The word 'SECOND' has 6 different letters

=> Required number of arrangements = 

= 
Instructions

Study the following table carefully and answer the questions that follow:
No of employees from six different banks located in different cities, M = males, F = Females

S.I. = 100
Principal×Rate×time

100
10,000×3×2

600

∴

600 × 3
100

20, 000

6!

6 × 5 × 4 × 3 × 2 × 1 = 720
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Question 140

What is the ratio of number of males to the number of females respectively in Bank D from all the cities
together?

A  496: 387

B  487: 356

C  422: 385

D  486 : 397

E    None of these
Answer: A

Explanation:
Number of males in Bank D from all the cities together
= 534 + 478 + 235 + 255 + 124 + 358 = 1984
Number of females in Bank D from all the cities together
= 454 + 285 + 235 + 175 + 165 + 234 = 1548
=> Required ratio = 1984 : 1548
= 496 : 387
Question 141

What is the ratio of the number of males to the number of females respectively in Patna from Bank A,
Bank C and Bank E together?

A  175: 173

B  177 : 173

C  177 : 172

D  175: 172

E    None of these
Answer: C

Explanation:
Number of males respectively in Patna from Bank A, Bank C and Bank E together
= 234 + 350 + 124 = 708
Number of females respectively in Patna from Bank A, Bank C and Bank E together
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= 120 + 234 + 334 = 688
=> Required ratio = 708 : 688
= 177 : 172

Question 142

What is he approximate average of the number of males working in all the banks together in Kolkata?

A  350

B  310

C  340

D  380

E    360
Answer: B

Explanation:
Total number of males working in all the banks together in Kolkata
= 353 + 348 + 399 + 358 + 125 + 278 = 1861

=> Required average =  = 310.17

 310
Question 143

The number of females in all the banks together in Delhi are approximately what percent of the number
of males from all the banks together in the same city?

A  88

B  98

C  78

D  68

E    58
Answer: A

Explanation:
Number of females in all the banks together in Delhi
= 456 + 256 + 345 + 285 + 166 + 287 = 1795
Number of males in all the banks together in Delhi
= 254 + 346 + 366 + 478 + 256 + 346 = 2046

 Required % = 

 = 90 %

 88 %

6
1861

≈

∴ ×2046
1795

100

≈ ×2000
1800

100

≈
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Question 144

The number of females in Bank B from Agra are what percent of the females in Bank C from the same
city?

A  33.2

B  23.2

C  13.2

D  28.2

E    None of these
Answer: B

Explanation:
Number of females in Bank B from Agra = 116
Number of females in Bank C from Agra = 500

=> Required % =  = 23.2 %

Instructions
For the following questions answer them individually
Question 145

What is the value of (x) in the following equation? 

A  17

B  19

C  16

D  14

E    None of these
Answer: E

Explanation:

Expression : 

=> 

=> 

=> 
Question 146

The average speed of a train is 3 times the average speed of a car. The car covers a distance of 520 kms
in 8 hours. How much distance will the train cover in 13 hours?

A    2553 kms

B    2585 kms

×500
116

100

=36
(x)0.7

(x)1.3
9

=36
(x)0.7

(x)1.3
9

(x) =0.7+1.3 9 × 36

(x) =2 324

x = =324 18
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C    2355 kms

D    2535 kms

E    None of these
Answer: D

Explanation:
Speed of car = 

=  kmph

=> Speed of train =  kmph

 Distance covered by train in 13 hours

=  km
Question 147

The area of a triangle is half the area of square. The perimeter of the square is 224 cms. What is the area
of the triangle?

A  

B  

C  

D  

E    None of these
Answer: E

Explanation:
Perimeter of square = 224 cms

=> Side of square =  cm

Area of square = 

 Area of triangle = 

= 

Question 148

Yesterday Priti type an essay of 5000 words at the speed of 60 words per minute: Today she type the
same essay faster and her speed was 15% more than yesterday. What is the approximate difference in
the time she took to type yesterday and the time she took to type today?

A  20 minutes

B  30 minutes

C  10 minutes

D  40 minutes

Time
Distance

=8
520

65

65 × 3 = 195

∴

13 × 195 = 2535

1856cm2

1658cm2

1558cm2

1586cm2

=4
Perimeter

=4
224

56

(56) =2 3136cm2

∴ cm2
3136 2

1568cm2
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E    1 hour
Answer: C

Explanation:
Priti's second day typing speed =  = 69 wpm
Required difference in time

= 

= 

 10 minutes
Question 149

How much will be the compound interest to be paid on a principle amount of Rs.85,000/-after 3 years at
the rate of 6 p.c:p.a:?

A  Rs.16623.36/-

B  Rs.16236.36/-

C  Rs. 16326.36/-

D  Rs.16632.36/-

E    None of these
Answer: B

Explanation:
C.I. = 

= 

= 

= 

= Rs. 
Instructions

What approximate value should come in place of the question mark (?) in the flowing questions? (Note : You are not
expected to calculate the axact value).
Question 150

A  835

B  795

C  695

D  685

E    715
Answer: E

Explanation:
Expression : 

×100
115

60

( −60
5000

)69
5000

5000( )60×69
69−60

≈

P [1 + −100
R T

1]

85, 000[(1 + ) −100
6 3 1]

85, 000[(1.06) −3 1] = 85, 000[1.191016 − 1]

85, 000 × 0.191016

16, 236.36

635 × 455 ÷ 403 =?

635 × 455 ÷ 403 =?

1
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= 

= 

Question 151

A  8

B  38

C  58

D  68

E    18
Answer: E

Explanation:
Expression : 

We know that  and 
and 3375 < 5332 < 8000
=> 15 < 18 < 20
Since, the only option between 15 and 20 is 18.
Question 152

A  610

B  650

C  660

D  670

E    630
Answer: E

Explanation:
Expression : 

Question 153

A    135

635 × 455 × 400
1

722 ≈ 715

=3 5332 ?

=3 5332 ?

≈ =3 5832 18

15 =3 3375 20 =3 8000

105.003 + 307.993 + 215.630 =?

105.003 + 307.993 + 215.630 =?

≈ 105 + 308 + 216 = 629

≈ 630

5223 ÷ 36 × 0.93 =?
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B    125

C    145

D    155

E    115
Answer: C

Explanation:
Expression : 

= 

Question 154

A  57

B  47

C  67

D  37

E    27
Answer: B

Explanation:
Expression : 

= 
Instructions

Study the following graph carefully and answer the questions that follow:
% of employees in different departments of a company
Total no of employees = 4500

% of females in each department in the same company
Total no of female in the organization = 2000

5223 ÷ 36 × 0.93 =?

≈ ×36
5220

1

145 × 1 = 145

=2228 ?

=2228 ?

≈ 2209

47
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Question 155

The number of females in the Marketing department are approximately what percent of the total
employees in Marketing and Customer Relation Departments together?

A  26

B  36

C  6

D  46

E    16
Answer: E

Explanation:

Number of females in the Marketing department = 280
Total employees in Marketing and Customer Relation Departments together = 810 + 990 = 1800

=> Required % = 

= 15.6 %  16 %
Question 156

The total number of females are what percent of the total number of males in the organization?

A    90

×1800
280

100

≈

.
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B    70

C    80

D    60

E    None of these
Answer: C

Explanation:
Total number of females = 2000
Total number of males = 4500 - 2000 = 2500

=> Required % =  = 80 %

Question 157

What is the ratio of number of males in HR department to the number of males in Accounts department
respectively?

A  3 : 17

B  4: 15

C  2 : 15

D  2 : 13

E    None of these
Answer: C

Explanation:

Number of males in HR department = 40
Number of males in Accounts department = 300
=> Required ratio = 40 : 300
= 2 : 15
Question 158

What is the total number of males from Design, Customer Relation and HR departments together?

A    1550

B    1510

×2500
2000

100
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C    1540

D    1580

E    None of these
Answer: B

Explanation:

Total number of males from Design, Customer Relation and HR departments together
= 880 + 590 + 40 = 1510
Question 159

What is the respective ratio of number of employees in Administerative department to the number of
males in the same department?

A  9 : 4

B  8 : 3

C  7 : 2

D  8 : 5

E    None of these
Answer: A

Explanation:

Number of employees in Administrative department = 360
Number of males in Administrative department = 160
=> Required ratio = 360 : 160
= 9 : 4

.
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Reasoning
Instructions
For the following questions answer them individually
Question 160

How many meaningful English words can be formed with the letters 'ADIC' using each letter only once in
each word?

A  None

B  One

C  Two

D  Three

E    More than three
Answer: B

Explanation:
Meaningful English words can be formed with the letters 'ADIC' using each letter only once in each word
Only 1 word can be formed = Acid
=> Ans - (B)

Question 161

Four of the following five are alike in a certain way and so form a group, which isthe one tat does not
belong to that group?

A  Violin

B  Harp

C  Guitar

D  Flute

E    Sitar
Answer: D

Explanation:
Apart from flute, all of violin, guitar, harp and sitar are string instruments, hence flute is the odd one out.
=> Ans - (D)
Question 162

If it is possible to make only one meaningful word with the first, fourth, fifth and tenth letters of the
word Television, which of the following would be the second letter of that word from the right end? If no
such word can be made, give ‘X’ as your answer and if more than one such word can be formed, give your
answer as ‘Y’.

A    X

B    L

C    N
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D    E

E    Y
Answer: C

Explanation:
Word - TELEVISION
1st, 4th, 5th and 10th letters = T,E,V,N
Only one word can be formed = Vent
2nd letter from right end = 'N'
=> Ans - (C)
Question 163

In a certain code TRUMP is written SUTQN. How is FIRED written in that code?

A  GJQEF

B  JGEQF

C  JQGEF

D  JGQFE

E    JGQEF
Answer: E

Explanation:
TRUMP is written SUTQN
The pattern followed is :

Similarly, for FIRED :

=> Ans - (E)

Question 164

In a certain language ‘give me more’ is coded as ‘7 3 5’, ‘she has more’ is coded as ’9 7 1′ and ‘she asked 
me gently’ is coded as ‘6 3 2 1′. Which of the following is the code for’give’ in that language?

A    5

B    7
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C    6

D    9

E    1
Answer: A

Explanation:
The common word in the first two statements is 'more' coded as = 7
Similarly, the common word in the last two statements is 'me' coded as = 3
=> Only word left in 1st statement is 'give' coded as = 5
=> Ans - (A)
Question 165

If each of the vowels in the word GOLIATHS is changed to the next letter in the English alphabetical
series and each consonant is changed to the previous letter in the English alphabetical series, and then
the alphabets so formed are arranged in alphabetical order from left to right, which of the following will
be sixth from the left of the new arrangement thus formed?

A  S

B  P

C  G

D  J

E    F
Answer: B

Explanation:
Word - 'GOLIATHS'
If each vowel is changed to next letter in the English alphabetical series and each consonant is changed to previous
letter in English alphabetical series, then new word - 'FPKJBSGR'
Word after arranging in alphabetical order = 'BFGJKPRS'
6th from the leftt end = P
=> Ans - (B)
Question 166

In a certain language ‘WEAK’ is coded as ‘4β#7’ and ‘WREK’ is coded as ‘4$β7’. How will ‘KEWRA’ be
coded in the same code?

A  7 4 $ β #

B  β 7 $ 8 #

C  # β 9 7 4

D  $ β 7 9 4

E    7β4$#
Answer: E

Explanation:
The codes for each letter is given :
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K -> 7
E -> β
W -> 4
R -> $
A -> #
Thus, KEWRA : 7β4$#

=> Ans - (E)

Question 167

How many such pairs of letters are there in the word FORMATION each of which has as many letters
between them in the word (in both forward and backward directions) as they have between them in the
English alphabetical order?

A  None

B  One

C  Two

D  Three

E    More than three
Answer: D

Explanation:
Word - 'FORMATION'
There are 3 pairs of letters which have as many letters between them in the word as they have between them in the
English alphabetical series.
= (O,M) , (O,N) , (F,N)
=> Ans - (d)
Question 168

If the digits in the number 79246358 are arranged in descending order from left to right, what will be the
difference between the digits which are third from the right and second from the left in the new
arrangement?

A  1

B  2

C  3

D  4

E    5
Answer: D

Explanation:
Number - '79246358'
If the digits are arranged in descending order from left to right, new number = 98765432

Difference between the digits which are third from the right and second from the left = 
=> Ans - (D)
Question 169

‘Music’ is related to ‘Notes’ in the same way as ‘Language’ is related to………………

8 − 4 = 4
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A  Sentences

B  Combination

C  Grammar

D  Alphabets

E    Syntax
Answer: A

Explanation:
Music is composed from notes, similarly a language is made from sentences.
=> Ans - (A)

Instructions

Read the following information carefully and answer the questions which follow:
If ‘P * Q’ means ‘P is the mother of Q’.
If ‘P × Q’ means ‘P is the father of Q’.
If ‘P + Q’ means ‘P is the sister of Q’.
If ‘P — Q’ means P is the brother of Q’.
If ‘P > Q’ means ‘P is the son of Q’.
If ‘P < Q’ means ‘P is the daughter of Q’.
Question 170

In the expression ‘A × B + R > S’ how is S related to A?

A  Daughter-in-law

B  Daugher

C  Wife

D  Sister

E    Cannot be determined
Answer: C

Explanation:
Expression : A × B + R > S
A is the father of B and B is the sister of R.
R is the son of S.
=> A is the husband of S, their children are B(female) and R(male)
Thus, S is the wife of A.
=> Ans - (C)
Question 171

Which of the following means P is the father of S?

A    P × Q < R * S

B    R × P < Q - S
C    R + S > Q + P
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D    S + Q - R * P

E    Cannot be determined
Answer: A

Explanation:
(A) : P × Q < R * S
P is the father of Q, who is the daughter of R, => R is wife of P
Also, R is mother of S, => P is the father of S.
=> Ans - (A)
Question 172

In the expression ‘P + Q > A — B’ how is P related to B?

A  Daughter

B  Son

C  Niece

D  Newphew

E    Cannot be determined
Answer: C

Explanation:
Expression = P + Q > A — B
=> P is the sister of Q, and Q is son of A, => P(female) and Q(male) are siblings.
Also, A is brother of B, => A is the father of P and Q.
Thus, P is the niece of B.
=> Ans - (C)

Question 173

Which of the following means D is the aunt of C?

A  D > B * A + C

B  D + B — C * A

C  D — B — A × C

D  D + B × A × C

E    None of these
Answer: E

Explanation:
(A) : D > B * A + C, => D is the son of B, thus D is male and cant be aunt.
(B) : D + B — C * A
=> D is sister of B, who is brother of C, thus D is sister of C.
(C) : D — B — A × C
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=> D is brother of B, thus D is male and cant be aunt.
(D) : D + B × A × C
=> D is sister of B, who is father of A, who is father of C, thus D is aunt of A, not of C.
=> Ans - (E)
Question 174

In the expression ‘W > X < Y * Z’ how is W related to Z?

A  Nephew

B  Uncle

C  Son

D  Brother-in-law

E    None of these
Answer: A

Explanation:
Expression : W > X < Y * Z
W is the son of X and X is daughter of Y, => W is grandson of Y.
Y is mother of Z, => X is sister of Z.
Thus, W is nephew of Z.
=> Ans - (A)
Instructions

In each question below are given three statements followed by two conclusions numbered I and II You have to take
the given statements to be true even if they seem to be at variance from commonly known facts and then decide
which of the given contusions logically follows from statements disregarding commonly known facts.
a: if only conclusion I follows.
b: if only conclusion II follows.
c: if either conclusion I or conclusion II follows.
d: if neither conclusion I nor conclusion II follows.
e: if both conclusions I and II follow.
Question 175

Statements: 
All medicines are tablets. 
Some tablets are tonics.
Some tonics are bitter.
Conclusions: 
I. Some tablets are bitter.
II. No medicines is a tonic.

A  if only conclusion I follows.

B  if only conclusion II follows.

C  if either conclusion I or conclusion II follows.

D  if neither conclusion I nor conclusion II follows.
E    if both conclusions I and II follow.

Answer: D
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Explanation:
The venn diagram for above statements is :

Conclusions: 
I. Some tablets are bitter = may or may not be true
II. No medicines is a tonic = false
Thus, neither conclusion I nor conclusion II follows.
=> Ans - (D)

Question 176

Statements: 
All incomes are salaries. 
Some salaries are perks. 
Some perks are tangible:
Conclusions: 
I. Some incomes are tangible.
II. At least some perks are salaries.

A  if only conclusion I follows.

B  if only conclusion II follows.

C  if either conclusion I or conclusion II follows.

D  if neither conclusion I nor conclusion II follows.

E    if both conclusions I and II follow.
Answer: B

Explanation:
The venn diagram for above statements is :

Conclusions: 
I. Some incomes are tangible = false
II. At least some perks are salaries = true
Thus, only conclusion II follows.
=> Ans - (B)
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Question 177

Statements: 
All roses are red: 
Some red are colour. 
All colour are paints.
Conclusions: 
I. Some red are paints.
II. All red are roses.

A  if only conclusion I follows.

B  if only conclusion II follows.

C  if either conclusion I or conclusion II follows.

D  if neither conclusion I nor conclusion II follows.

E    if both conclusions I and II follow.
Answer: D

Explanation:
The venn diagram for above statements is :

Conclusions: 
I. Some red are paints = may or may not be true
II. All red are roses = false
Thus, neither conclusion I nor conclusion II follows.
=> Ans - (D)
Question 178

Statements: 
Some casual are formal. 
All formal are expensive.
All expensive are elegant.
Conclusions: 
I. All formal are elegant.
II. Some casual are expensive.

A  if only conclusion I follows.

B  if only conclusion II follows.

C  if either conclusion I or conclusion II follows.

D  if neither conclusion I nor conclusion II follows.
E    if both conclusions I and II follow.

Answer: E
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Explanation:
The venn diagram for above statements is :

Conclusions: 
I. All formal are elegant = true
II. Some casual are expensive = true
Thus, both conclusions I and II follow.
=> Ans - (E)

Question 179

Statements: 
All towns are cities. 
All cities are urban. 
Some urban are rural.
Conclusions: 
I. Some towns are rural.
II. All rural are towns.

A  if only conclusion I follows.

B  if only conclusion II follows.

C  if either conclusion I or conclusion II follows.

D  if neither conclusion I nor conclusion II follows.

E    if both conclusions I and II follow.
Answer: D

Explanation:
The venn diagram for above statements is :
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Conclusions: 
I. Some towns are rural = false
II. All rural are towns = false
Thus, neither conclusion I nor conclusion II follows.
=> Ans - (D)
Instructions

The following questions are based on five words given below: RAT ONE BUT AND SAW (The new words formed after
performing the mentioned operations may or may not necessarily be meaningful English words.)
Question 180

If in each of the given words, each alphabet is changed to the next letter in to English alphabetical
series, in how many words thus formed have the consonants changed to vowels?

A  One

B  Two

C  Three

D  Four

E    Five
Answer: D

Explanation:
Words : RAT ONE BUT AND SAW
If each alphabet is changed to the next letter in to English alphabetical series, then new words :
SBU , POF , CVU , BOE , TBX
Thus, in 4 words thus formed the consonants have changed to vowels.
=> Ans - (D)
Question 181

How many such pairs of letters are there in the word highlighted in bold, each ofwhich has as many 
letters between them in the word (in botrh forward and backward directions) asthey have between them 
in the English alphabetical order?

A    None

B    One

C    Two
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D    Tlire

E    Four
Answer: D

Question 182

If in the given words only consonants are changed with their successive letters and vowels are kept same 
then in how many words the vowel same or different will come twice or more than two times?

A  None

B  One

C  Two

D  Three

E    Four
Answer: E

Explanation:
Words : RAT ONE BUT AND SAW
If only consonants are changed with their successive letters and vowels are kept same , then new words :
SAU , OOE , CUU , AOE , TAX
Thus, in 4 words thus formed the vowel same or different will come twice or more than two times.
=> Ans - (E)
Question 183

If the first letter of every word is changed with successive letter then how many meaningful word will be
formed:

A  One

B  two

C  three

D  four

E    five
Answer: B

Explanation:
Words : RAT ONE BUT AND SAW
If the first letter of every word is changed with successive letter, then new words :
SAT , BNE , CUT , BND , TAW
Only 2 meaningful word will be formed.
=> Ans - (B)
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Question 184

If the given words are arranged alphabetically from left to right then which one ofthe following will be
fourth from left.

A  RAT

B  ONE

C  BUT

D  AND

E    SAW
Answer: A

Explanation:
the given words are  RAT ONE BUT AND SAW 
arranging alphabetically 
AND BUT ONE RAT SAW
and hence fourth word from left side = RAT

Instructions

Study the information carefully and answer the questions.
Five friends P Q R S and T travel from Goa individually for the five cities ie: Chennai, Kolkata, Delhi, Hydrabad and 
Manglore by different means of transport ie:, bus, train, aeroplane, car and boat. One who traveled for Delhi did not 
use boat. R traveled for Manglore by car and S traveled by boat. Q traveled by aeroplane for Kolkata and T traveled by 
train. Delhi and Chennai in not connected with bus roate with Goa:
Question 185

Which combination of place and transport of the following is true:

A  Kolkata-bus

B  Delhi-aeroplane

C  Manglore -train

D  Chennai-boat

E    Hydrabad-car
Answer: D

Explanation:
R travelled by car, S by boat, Q by airplane and T by train.
=> P travelled by bus.
Also, R travelled for Mangalore and Q for Kolkata.
Delhi and Chennai are not connected with bus route with Goa, => P, who use bus travelled to Hyderabad.
Also, one who traveled for Delhi did not use boat, => S travelled to Chennai and T to Delhi.
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The only true combination is about the person who went to Chennai used boat.
=> Ans - (D)
Question 186

Q : Kolkata Similarly, S : ?

A  Hydrabad

B  Chennai

C  Manglore

D  Delhi

E    Can not be determined
Answer: B

Explanation:
R travelled by car, S by boat, Q by airplane and T by train.
=> P travelled by bus.
Also, R travelled for Mangalore and Q for Kolkata.
Delhi and Chennai are not connected with bus route with Goa, => P, who use bus travelled to Hyderabad.
Also, one who traveled for Delhi did not use boat, => S travelled to Chennai and T to Delhi.

Q travelled to Kolkata. Similarly, S travelled to Chennai.
=> Ans - (B)
Question 187

Who of the following traveled for Delhi?

A    T

B    R
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C    S

D    P

E    Q
Answer: A

Explanation:
R travelled by car, S by boat, Q by airplane and T by train.
=> P travelled by bus.
Also, R travelled for Mangalore and Q for Kolkata.
Delhi and Chennai are not connected with bus route with Goa, => P, who use bus travelled to Hyderabad.
Also, one who traveled for Delhi did not use boat, => S travelled to Chennai and T to Delhi.

Clearly, T travelled to Delhi.
=> Ans - (A)

Question 188

Which combination of the following is true for P.

A  traveled by bus for Kolkata

B  traveled by train for Delhi

C  traveled by boat for Chennai

D  traveled by bus for Hyderabad

E    None of these
Answer: D

Explanation:
R travelled by car, S by boat, Q by airplane and T by train.
=> P travelled by bus.
Also, R travelled for Mangalore and Q for Kolkata.
Delhi and Chennai are not connected with bus route with Goa, => P, who use bus travelled to Hyderabad.
Also, one who traveled for Delhi did not use boat, => S travelled to Chennai and T to Delhi.
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P travelled by bus for Hyderabad.
=> Ans - (D)
Question 189

S traveld for…………….. by……………

A  Hydrabad, train

B  Chennai, boat

C  Chennai, train

D  Delhi, boat

E    Delhi, train
Answer: B

Explanation:
R travelled by car, S by boat, Q by airplane and T by train.
=> P travelled by bus.
Also, R travelled for Mangalore and Q for Kolkata.
Delhi and Chennai are not connected with bus route with Goa, => P, who use bus travelled to Hyderabad.
Also, one who traveled for Delhi did not use boat, => S travelled to Chennai and T to Delhi.

S travelled for Chennai by boat.
=> Ans - (B)
Instructions

In each of the questions given below which one of the five answer figures on the right should come after the problem 
figures on the left, if the sequence were continued?
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Question 190

A 

B 

C 

D 

E 

Answer: A
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Question 191

A 

B 

C 

D 

E 

Answer: B

Explanation:
Let's divide the pattern into 4 portions, left, right, top and bottom.
In the top portion, there is an alternating pattern of the black side of the box, so the black side will be at top in solution 
figure.
In the left and bottom portion, the black side of the box is rotating in clockwise direction, so the black side will be at 
right and top side respectively in solution.
In the right portion, the black side of the box is rotating anti clockwise in pairs of 2.
Thus, option (B) satisfies above conditions.
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Question 192

Figure

A  figure1

B  figure2

C  figure3

D  figure4

E  figure5
Answer: E

Question 193

Figure

A  figure1

B  figure2

C  figure3

D  figure4

E  figure5
Answer: A

Question 194

Figure

A  figure1

B  figure2

C  figure3

D  figure4

E  figure5
Answer: A

Question 195

Figure

A  figure1

B  figure2

C  figure3

D    figure4
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E  figure5
Answer: C

Question 196

Figure

A  figure1

B  figure2

C  figure3

D  figure4

E  figure5
Answer: B

Question 197

Figure

A  figure1

B  figure2

C  figure3

D  figure4

E  figure5
Answer: C

Question 198

Figure

A  figure1

B  figure2

C  figure3

D  figure4

E  figure5
Answer: E

Question 199

Figure

A  figure1

B  figure2
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C    figure3

D    figure4

E    figure5
Answer: A
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